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Jova Solutions provides advanced hardware and software products 

and custom applications for process control, data management, test, 

measurement, and automation. 

Jova Solutions was founded in 2000 and is located in Berkeley, California. 

 

Please contact us with any questions or to request a FermWorks quote. 

fwsupport@jovasolutions.com 

www.jovasolutions.com 

1-866-755-1400 
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What is FermWorks? 

FermWorks is a software application that automates processes, from simple lab experiments to large-scale 

manufacturing. FermWorks communicates with a wide variety of instruments and devices to acquire data 

from them and control their operations. FermWorks has been used successfully in labs and pilot plants for 

over a decade, at sites such as leading pharmaceutical corporations, biofuels and  biopharm start-ups, 

other process control facilities, and academic institutions. FermWorks stores, analyzes, and displays the 

data, controls the process continuously and with specific recipes (methods) during experiments, generates 

reports, and manages users and security. It is a turnkey system, ready to use immediately, yet easily 

customized and extended for specific needs. FermWorks can run on a single computer or as a networked 

distributed system supporting an unlimited number of users, computers, instruments, and process tags. 

 

What is the FermWorks Demo? 

The demo version of FermWorks has most of the functionality of the FermWorks application. The demo 

does not include the device drivers that communicate with instruments and devices from a wide variety of 

vendors, but communication with instruments that provide a standard OPC Server is supported. In 

addition, some simulated devices (Digital Control Units, DCU's) are included in the demo to provide 

simulated data. 

The FermWorks demo does not support the networked capabilities of the full FermWorks application, 

that allows shared data and control among multiple computers on a network. In the demo, there is only 

one computer running FermWorks, and this is called "Station 1." In a networked installation, there would 

be any number of FermWorks "stations," and each could show data from or control the process on any of 

the others. 

The FermWorks demo may be used for evaluation purposes for one month, after which it will 

no longer run. Instead, a dialog will remind you to contact Jova Solutions to purchase a 

license to continue using FermWorks. 

 

Contact Jova Solutions at any time during or after the demo period to 

request a FermWorks quote to get started with real data management and 

process control. 

 

fwsupport@jovasolutions.com 

www.jovasolutions.com 

1-866-755-1400 
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Installation of FermWorks 
 

System Requirements 

FermWorks requires a computer running Windows XP or 7, with a minimum of 2 GB RAM. 

Acrobat Reader is required for displaying the FermWorks Help documentation. 

 

FermWorks Demo Installation  

IMPORTANT: After installation, your computer will be restarted automatically. Please save your work 

and exit all other applications before running the FermWorks installer. After the restart, FermWorks will 

be automatically configured for first-time use. 

Run the FermWorks Demo Installer. The installer will ask you to select the location where FermWorks 

should be installed. The default is C:\FW. Click Next to start the installation to this folder. 

After the installation of the application, the FermWorks installer still needs to install other supporting 

components, restart the computer, and then configure FermWorks for first-time use. When you see 

Installation Complete as shown in Figure 1, click Next and please wait until all components are 

installed and your computer has restarted. 

 

Figure 1: Installation Complete : click Next and then please wait for your computer to restart. 

  



FERMWORKS 3.0 DEMO : GETTING STARTED GUIDE  5/7/13 
 

fwsupport@jovasolutions.com Page 4 of 12 www.jovasolutions.com 

FermWorks Demo Configuration  

After your computer has restarted, login to Windows. The FermWorks Demo Configuration will start 

automatically, as shown in Figure 2. Please wait while FermWorks gathers the necessary system 

information. 

 

Figure 2: FermWorks Configuration: Gathering system information , please wait 

 

You might be asked to allow changes to your computer, as shown in Figure 3. Click Yes. 

 

Figure 3: Allow changes: Click Yes 
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When ready for configuration,  the window changes to look like Figure 4. Click the Continue button. 

 

Figure 4: FermWorks Configuration: Click Continue 
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When the subsequent FermWorks Configuration Progress completes all its steps successfully as shown in 

Figure 5, click OK when prompted to save the installation log file, and then click CLOSE on the progress 

window. 

 

Figure 5: FermWorks Configuration Progress: Completed successfully 

 

You are now ready to run FermWorks. 
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Getting Started 

Run FermWorks by double-clicking its shortcut icon on the desktop. 

 

 

The following section will give you a tour to help you become familiar with the main features of 

FermWorks. All FermWorks functionality and its many displays are described in more detail in the 

FermWorks User Manual, that you can open by selecting FermWorks Help from the Help menu.  

 

1.  Log in 

FermWorks has its own users and security feature, separate from Windows users, so that facilities that 

need a high level of security can enable and disable selected FermWorks functionality for individual users 

or user groups, while facilities or single users without that concern may make all functionality accessible. 

In the FermWorks demo, there is a pre-configured user with access to all demo functionality. Select 

Login from the File menu and enter "fermworks3" for both the user name and password. 

 

 

2.  View Live Data 

The Overview display is the main display in FermWorks. It can show three different groups (datasets) of 

current process values in tables, with the third dataset also plotted on a graph as data are acquired. 

In the dropdown lists under Upper Datasets, select "Basic Process Values" for one, and "Most Tags" for 

the other. For Lower Dataset, select "Values and Setpoints." 

Observe the data in the tables and graph. Some values in the tables will show they are in an alarm state 

with a colored background. The blinking red and yellow light at the right also indicates an alarm state. 

Click on it to see details, if you like. 
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3.  Change Setpoints 

The FermWorks demo simulates a response to setpoint changes for certain process values, or "tags." 

Select Tag Value from the Process menu. Select "Values and Setpoints" as the Dataset. As an exercise, 

change the pH target value (setpoint) by double-clicking on the line in the table showing "Reactor A 

:pH_CS." Enter 7 for Tag Value and click OK. Click the Send button to commit the change. Close the 

Tag Value window or move it to the side. 

On the Overview graph, watch the pink dotted pH_CS setpoint plot move to the new value of 7, and the 

solid pink pH plot slowly drop in response. 

 

4.  View Historic Data 

The Overview display shows current data, a snapshot of the process status in real time. To view past data, 

open the Trends display from the Analysis menu. This display shows one dataset in both table and graph 

form, and offers many more options for recalling historic data by date, by experiment name, or just by 

scrolling back in time.  

There are other displays that show data from multiple experiments and/or multiple datasets, either 

independently (Trends Comparison, Trends Quad) or overlayed (Trends Overlay).  

Take some time to investigate the features of these displays. Read more detailed information about these 

displays in the User Manual (FermWorks Help). 

 

5.  Run Experiments and Recipes 

An experiment is the collection of data during a specified time period, often while running recipes to 

control the process. An experiment is composed of one or more cases, and each case can have a different 

bioreactor, or different recipes, or different recipe parameters, so that one experiment can include a 

variety of operating conditions. 

This FermWorks demo has a few experiments and recipes already configured. These show just a small 

subset of the control functionality available. FermWorks includes a large library of control algorithms and 

data analysis functions that can be configured and expanded by users. 

From the Process menu, select Experiment >> Status. The Experiment Status display shows all 

experiments that have been run (Completed), are running (Running), or are waiting to be run 

(Configured). Expand an experiment to see its cases, and expand a case to see which bioreactor and 

recipes it used. 

Close the Experiment Status display when you are finished exploring it. 
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Switch to the Trends display to see the data collected during each experiment. On the Trends display, 

select an experiment and dataset pair from the following: 

Experiment "Dual-Reactor Ramping Example" with Dataset "DO2 Tags" 

Experiment "Dissolved Oxygen Example" with Dataset "Most Tags" 

Experiment "Ramping Example" with Dataset "Values and Setpoints" 

 

After selecting the Experiment and Dataset, click the Zoom to Experiment Time button to 

the right of the graph, outlined here in red. 

Now you can see the process values as they changed over the course of the experiment. 

To configure a new experiment, select Experiment >> Configure from the Process menu. The easiest 

way to create a new experiment is to copy a similar existing experiment. Select "Dual Reactor Ramping 

Example" from the Experiment list and click the copy button, outlined here in red. 

 

The new experiment will be named "Dual Reactor Ramping Example 1" by default, but you can enter any 

name you like. Change the recipe's "Stop Value" parameters in the lower-right table to 7 for pH and 50 

for DO2. Click OK to close the Experiment Configuration display. 

Open the Experiment Status display again. The new experiment is configured but has not yet been run, so 

you will find it listed under Configured Experiments. (If you do not see it, select Refresh from the Edit 

menu.) Click on the experiment's name to select it, then select Start from the Experiment menu. After 

the experiment initializes and starts, it will be listed under Running Experiments, and you can expand it 

there to watch the progress of the recipes. At the same time on the Trends display, select the experiment 

and the "DO2 Tags" dataset to watch the process data change as the experiment's recipes control the 

setpoints. Notice that the pH and DO2 ramps use the modified stop value parameters. 

After the recipes have finished (or at any time), click on the experiment name in the Experiment Status 

display, then select Stop from the Experiment menu. 

To modify a recipe or create a new one, select Recipe from the Process menu to open the Recipe 

Configuration display. Take a look at the example recipes, clicking on the various Recipe Steps and 

Inputs / Outputs to see how they are configured. Refer to the User Manual (FermWorks Help) to learn 

more about recipes. 

Often, more experienced researchers configure experiments and recipes as part of process development 

work, and lab technicians run those preconfigured experiments. In a full FermWorks system,  the users 

and security feature could be used to grant access to configuration displays for the researchers but not for 

the technicians. 
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6.  Enter Offline Values 

Most process values in FermWorks are online measurements from a sensor or instrument connected to the 

computer, such as pH and temperature, that are logged continuously as long as FermWorks is running. 

Other process values can be calculated from these measurements, such as the average pH or the rate of 

change of dissolved oxygen, and also logged continuously. Discrete values that cannot be measured 

directly, such as cell density as observed with a microscope, are called Offline Values and may be entered 

manually. All of these different kinds of process values can be displayed together in tables and on graphs, 

such as those on the Overview and Trends displays, and in reports. 

To enter or modify offline values, select Offline Values from the Process menu. 

Select the experiment "Ramping Example" and you will see the values that were 

entered for the three Offline tags. Click the New button, outlined here in red, to 

open a dialog where you can enter more values. 

First, change the Sample Time to 03/25/2013 01:45 PM. Next, enter values for each of the three offline 

tags, such as those shown below, and click OK. You will see the new values listed in the table on the 

Offline Value display, and if you open the Trends display and select the "Ramping Example" experiment 

and the "Most Tags" dataset, you will see those values on the graph. 

For more about Offline Values, refer to the User Manual (FermWorks Help). 

 

 

7.  Generate a Report 

Data collected during an experiment can be viewed and exported in standard spreadsheet (tab-delimited) 

format with the Report Generation display, in the Analysis menu. Any number of different reports can 

be configured to include different process values and calculations. Select an experiment from the list, and 

then select the report named "Simple PV CS." Click the Generate button to create this pre-configured 

report of some basic tags and their setpoints at 5-second intervals. You could save the report data to a file 

by selecting Export Data from the File menu. 

It is not necessary to export the data to a file because FermWorks stores all data securely in a database, 

which can be archived automatically. Also, most common data analysis functions can be done directly in 

FermWorks. However, it can be useful sometimes to export data for import into other software systems.  
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8.  View a Custom Display 

If you would like to view your process data in a different way, perhaps using graphics to show the layout 

of your specific process, you can add a custom display to FermWorks. Select Sample Display from the 

Analysis menu to see an example of a custom display, as shown below. Creating a custom display is 

beyond the scope of this demo, but you can read about it in the User Manual (FermWorks Help). 
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What's Next? 

Continue to explore the features of FermWorks with the help of the User Manual (FermWorks Help). 

Try out other displays, create a new dataset, or take a look at the configuration of a bioreactor. Let us 

know what kinds of devices and analytical instruments provide the data for your process, and we can help 

you integrate all of them into one coherent data management and control system with FermWorks.  

 

 

Contact Jova Solutions at any time during or after the demo period to 

request a FermWorks quote to get started with real data management and 

process control. 

 

fwsupport@jovasolutions.com 

www.jovasolutions.com 

1-866-755-1400 

 


